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Starlight Xpress Ltd

SXV-M9
CCD camera user manual

Thank you for purchasing a Starlight Xpress CCD camera. \Ofeetthat you will be
very satisfied with the results. The SXV-M9 is gliresolution cooled CCD camera,
especially designed for astronomical imaging. TR¥$/9 uses a Sony SuperHAD
CCD, with 752 x 582 pixels in a 6.5mm x 4.8mm aetarea. SuperHAD devices
have an excellent quantum efficiency across thiéleisnd near infra-red spectrum
and the use of high performance microlenses o @ surface gives the greatest
possible throughput of light to the pixels. Thisngaa is a next generation version of
the parallel port driven MX916, but the use of areinal USB2 interface and the
addition of an external guide camera option makesrisiderably more effective.

Please note that the SXV-M9 can be operated irrakedéferent imaging modes. The
easiest to use is ‘Fast’, which creates an image & single exposure and so this is
the mode used in the operating instructions beleast’ mode does give a slightly
reduced vertical resolution in the output imagéd,this is barely detectable unless
observing conditions are extremely good. ‘Progressind ‘Interlaced’ modes will

be described later.

Please take a few minutes to study the contertta©manual, which will help you to
get the camera into operation quickly and withaobtems. | am sure that you want
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to see some results as soon as possible, so peageon to the ‘Quick Start’ section,
which follows. A more detailed description of imagitechniques will be found in a
later part of this manual.

‘Quick Starting’ your SXV-M9 system
In the shipping container you will find the follomg items:

1) The SXV-M9 camera head.

2) A power supply module.

3) A 3 metre USB camera cable.

4) An adaptor for 1.25” drawtubes.

5) A 2 inch diameter drawtube and M42 lens adaptor.
6) A CD with the ‘'SXV_M9’ software.

7) This manual.

You will also need a PC computer with Windows 988Hndows 2000 or Windows
XP. This machine must have at least one USB paeg(ly USB2.0) and at least 64
Megs of memory. If you intend to view the finishietages on its screen, then you
will also need a graphics card capable of dispagn image with a minimum of 800
X 600 pixels and 65,000 colours. A medium spedificaPentium with between
500MHz and 3GHz processor speed is ideal.

Connecting up:

Plug the 5 pin DIN connector into the socket ongbever supply box, and plug the
power supply into the wall socket. The yellow LEDthe power supply should light.

- B Ba . .
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Wiring up your SXV camera

Power
plug

Camera head

S pin plug

Line Plug

Power
Supply

12V DC input
(optional)

Plug into

USB socket

PC computer

Connect the miniature 4 way power plug to the sbokethe rear of the camera and
screw the retaining ring into place. The LED onnb& of the camera will light a dim
yellow. The other connections should not be attdah®il after the software has been
installed.

Installing the software:

Switch on the computer and allow it to ‘boot uphd you have the system ready to
run, insert the program disk into your CD drive @etect ‘Setup.exe’ if the disk does
not autostart. The initial installation is to setthe USB drivers required by the SXV
electronics. The files SXVIO.sys and Generic.syscpied to your
Windows\System32\Drivers folder and SXV_M9.inf @peed to Windows\Inf.

After this, the program ‘SXV_M?9.exe’ will be instadl into your ‘CCD’ directory

and a new directory called ‘Autosave’ will now exis the same drive. ‘Autosave’ is
where SXV_M9 will normally store its configuratidife, ‘SXVM9.ini’, and any

image files, which are recorded using the ‘Autosavede in SXV_M9 and saved in
FITs format.
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You now need to set up the camera control deféstiswn above), as follows:
Start SXV_M9 by clicking on the icon and select fiée’ menu. Now select ‘Set
program defaults’ and a window, which containswhagous software settings, will
appear. Suggested starting defaults are as follows:

1) Background Image area Red (or as preferred)
2) Interlaced image smoothing On
3) FITS Unsigned Integer format Off

4) Star mask size (area used for photometry and gg)idin 8 pixels

The other default settings are not important farent purposes and may be left as
the software start-up values for now.

Recording your first image:

We now have the camera and computer set up tiakees, but an optical system
is needed to project an image onto the CCD surfége.could use your telescope,
but this introduces additional complications, whiak best avoided at this early
stage. There are two simple options, one of wisckvailable to everyone:

1) Attach a standard ‘M42’ SLR camera lens to the SM¥-using a 27mm spacer
to achieve the correct focal distance. M42 thrgeters are available from most
photographic stores, or from Starlight Xpress dsale
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2) Create a ‘Pin hole’ lens by sticking a sheet ofahium baking foil over the end
of the 1.25” adaptor and pricking its centre witbnaall pin.

M42 Thread M42 Thread
Camera Lens

Camera
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— —

Sy gy i

Tripod Bracket 27mm M42 Adaptor
P CCD P
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Attaching a Pentax thread camera lens
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Pin Hole
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Elastic Band

W = -—L_TLTJL

Making a simple pin-hole lens

If you use a normal lens, then stop it down todimallest aperture number possible
(usually F22) as this will minimise focus problearsd keep the light level reasonable
for daytime testing. The pin hole needs no suchsdaajents and will work
immediately, although somewhat fuzzily.
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Multiple Exposure Optiong Camera Binni'ng
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Point the camera + lens or pinhole towards a vitelild clearly defined object some
distance away. Now click on the camera icon inttlmdbar of the SXV-M9 software
and the camera control panel will appear (see gb&etect an exposure time of 0.1
seconds and press ‘Take photo’. After the expoandedownload have completed
(between 1 and 3 seconds) an image of some kin@ppkar on the computer
monitor. It will probably be poorly focused and anectly exposed, but any sort of
image is better than none! In the case of the pamladl that you can experiment with
is the exposure time, but a camera lens can bstadjfor good focus and so you
might want to try this to judge the image qualligttit is possible to achieve.

One potential problem with taking daylight imageshe strong infrared response of
the SXV-M9 and this will cause ‘soft focus’ withroara lenses. Soft focus with
camera lenses is much reduced by keeping the apastting below F8. IR blocking
filters are available from various suppliers (Tfitechnology, Edmunds etc.) and are
recommended for the best results.

If you cannot record any kind of image, please check the following points:

1) Is the power LED on?

2) Does the software indicate that the camera eessssfully connected? An attempt
to take a picture will fail with an error messadehie USB is not properly installed. In
this case, try unplugging the USB cable and the@omeecting it after about 5



Handbook for SXV-M9 Issue 1 June 2004

seconds. Restart the camera software and seeahitink now. If not, check in
Windows device manager (via ‘System’ in ‘Controh&g and see if the BlocklO
device is installed properly.

3) If you cannot find any way of making the cameoak, please try using it with
another computer. This will confirm that the camsr®K, or otherwise, and you can
then decide how to proceed. Also check on our velicssee if there are any updates
or information about your camera software that ntigblp. The message board might
prove useful to ask for help with getting your cear@perating properly.

Our guarantee ensures that any electrical faults eorrected quickly and at no cost
to the customer.

Enhancing your image:

Your first image may now be reasonably good, big itnlikely to be as clear and
sharp as it could be. Improved focusing and exmoselection may correct these
shortcomings, and you may like to try them befqplyng any image enhancement
with the software. However, there will come a poithien you say, “That’s the best
that | can get” and you will want to experimenttwitarious filters and contrast
operations. In the case of daylight images, thegssing options are many, but there
are few that will improve the picture in a usefudyw

The most useful of these are the ‘Normal Contrastt&’ and the ‘High Pass Low
Power filter. The high pass filter gives a moderahprovement in the image
sharpness, and the effects of image processing.CHni be very effective on daylight
images. Too much high pass filtering results irkdarders around well-defined
features and will increase the ‘noise’ in an imeganacceptable levels, but the ‘Low
Power’ filter is close to optimum and gives a nycgharpened picture, as above.

The ‘Contrast’ routines are used to brighten (df)dioe image highlights and
shadows. A ‘Normal’ stretch is a simple linear gtem, where two pointers (the
‘black’ and ‘white’ limits) can be set at eithedsiof the image histogram and used to
define new start and end points. The image ddteseis mathematically modified so
that any pixels that are to the left of the ‘blapkinter are set to black and any pixels
to the right of the ‘white’ pointer are set to whiiThe pixels with values between the
pointers are modified to fit the new brightnesgrisition. Try experimenting with

the pointer positions until the image has a plepbnghtness and ‘crispness’.

At this point, you will have a working knowledge ledw to take and process an SXV-
M9 image. It is time to move on to astronomical gng, which has its own, unique,
set of problems!
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Astronomical Imaging with the SXV-M9
1) Getting the image onto the CCD:

It is fairly easy to find the correct focus settiiog the camera when using a standard
SLR lens, but quite a different matter when theiMdttached to a telescope! The
problem is that most telescopes have a large rahfgeus adjustment and the CCD
needs to be quite close to the correct positionreefou can discern details well
enough to optimise the focus setting. An additicrmmhplication is the need to add
various accessories between the camera and tekestopder that the image scale is
suitable for the subject being imaged and (somefjrieeinclude a ‘flip mirror’ finder
unit for visual object location.

A simple, but invaluable device, is the ‘par-foegiepiece’. This is an eyepiece in
which the field stop is located at the same distdnam the barrel end, as the CCD is
from the camera barrel end.

Evepiece
'S

Film cassette Field stop
contfainers

A home-made ‘par-focal” eyepiece

When the par-focal eyepiece is fitted into thedetgpe drawtube, you can adjust the
focus until the view is sharply defined and theeabpf interest is close to the field
centre. On removing the eyepiece and fitting thé@amera, the CCD will be very
close to the focal plane of the telescope and shiadord the stars etc. well enough
for the focus to be trimmed to its optimum setting

Several astronomical stores sell par-focal eyepidwat you can also make your own
with a minimum of materials and an unwanted KellmePlossl| ocular.

Just measure a distance of 22mm from the field stdipe eyepiece (equivalent to the
CCD to adaptor flange distance of the camera) askkran extension tube to set the
field stop at this distance from the drawtube &ut-down 35mm film cassette
containers are a convenient diameter for makinggaeer tube and may be split to
adjust their diameter to fit the drawtube.

Another popular solution to the ‘find and focusbptem is the ‘flip mirror’ unit.
These operate on a similar principle to the sitghs reflex camera, where a hinged



Handbook for SXV-M9 Issue 1 June 2004

mirror can drop into the light path and reflect tmage through 90 degrees into a
viewing eyepiece.

In this case, the camera and eyepiece are madegawith each other by locking
up the mirror, focusing the camera on an easy tlgach as a moderately bright star
and then flipping the mirror down to view the saster with the eyepiece. Once the
eyepiece has been locked into the correct posiiun can use it to focus on the
image by lowering the flip mirror and operating teescope focus wheel until the
image is sharp. When the mirror is raised, the enady fall onto the CCD surface
and should be accurately in focus. Most flip mimaits allow several adjustments to
be made, so that the image can be centred prapetyg eyepiece and CCD fields,
which are not necessarily coincident when you fitst your unit!

Eyepiece par-focal with CCD

Mirror UE Hinged miror  CCD
\l L
Light from
Telescope Camerda

Flip mirror unit
A typical flip-mirror finder/ focuser

Opinions vary as to the utility of flip mirrors. &l are a convenient way to find and
focus, but they add quite a bit of extra lengthwiaetn the camera and telescope. This
can be very inconvenient with Newtonians, and not aetter with SCTs, especially

if the assembly is somewhat flexible. They also enklifficult to use a focal reducer
with your camera, as the rapidly converging lighte from a reducer cannot reach all
the way through the flip mirror unit to the CCD fae. If you are using one of the
popular F3.3 compressors for deep sky imaging,willNOT be able to include a

flip mirror unit in front of your camera and a pgacal eyepiece is your best option.

Whichever device you use, it is necessary to set gpod optical match between your
MX7 and the telescope. Most SCTs have a focal aitevound F10, which is too

high for most deep sky objects and too low forglamets! This problem is quite easy
to overcome, if you have access to a telecompréksadeep sky) and a Barlow lens
for planetary work. The new Meade F3.3 compressuery useful for CCD imaging
and | can recommend it from personal experienatods not require a yellow filter

for aberration correction, unlike some other desjgo it can be used for colour
imaging. Barlow lenses are less critical and mysts$ can be used with good results.
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However, if you are buying one for CCD imagingetommend a 3x or 5x amplifier,
or the planets will still be rather small in yoarages. As a guide, most CCD
astronomers try to maintain an image scale of aB@ut seconds per pixel for deep
sky images. This matches the telescope resolutitimet CCD resolution and avoids
‘undersampling’ the image, which can result in sgustars and other unwanted
effects. To calculate the focal length requiredtfas condition to exist, you can use
the following simple equation:

F = Pixel size * 205920 / Resolution (in arc se®)nd
In the case of the SXV-M9 and a 2 arc seconds ipef gesolution, we get
F=0.0112 * 205920/ 2 =1153mm

For a 200mm SCT, this is an F ratio of 844 / 2022, which is easily achieved
with the Meade converter and appropriate extensiba (as supplied with the
converter). Moderate deviations from this focalgégnwill not have a drastic effect
and so any F ratio from about F3.3 to F6 will gied results.

The same equation can be used to calculate thefaampdn required for good
planetary images. However, in this case, the shergosures allow us to assume a
much better telescope resolution and 0.25 arc skscoer pixel is a good value to use.
The calculation now gives the following result:

F=0.0112 * 205920/ 0.25 =9225mm

This is approximately F34 when used with a 200mnT &ad so we will need a 3.4 x
Barlow lens. Such lenses are not available, buctimemon 3x version will be good
enough for all practical purposes.

An accessory that you will find valuable is the ‘Bltb T’ adaptor. These are short
tubes that carry an external M42 thread at oneaeddan internal ‘T’ thread at the
other end, and are available from most photograginply shops. The T thread is the
same diameter as the M42 (42mm x 1mm) thread tsuapatch of 0.75mm and is
used for many astronomical accessories, suchesotapressors. An M42 to T
adaptor will allow you to easily interface with tally any device in the astronomical
catalogue.

Achieving a good focus:

Your starting point will depend on the focus aifisny, which you are using. With
the par-focal eyepiece, you should slip the eyepieto the drawtube and focus
visually on a moderately bright star (abolitrBagnitude). Now withdraw the
eyepiece and carefully insert the camera nosepietiiet is bottomed against the
drawtube end and lock it in place. With the fliprmar unit, all that is needed is to
swing the mirror down and adjust the focus un# star is sharply defined and
centred in the viewing eyepiece. Now lift the miramd you are ready to start
imaging.

SXV_M9 has a focus routine that will repeatedly adévad and display a 100 x 100
pixel segment of the image at relatively high spdéts focus window may be

10



Handbook for SXV-M9 Issue 1 June 2004

positioned anywhere in the camera field and cadifigayed with an adjustable
degree of automatic contrast stretching (for faogsin faint stars). To use this mode,
start up the software and select the MX camerafate (File menu). Set the camera
mode to ‘Fast’ and select an exposure time of brsdcPress ‘Take Picture’ and wait
for the image to download. There is a good chahaeyour selected star will appear
somewhere within the image frame and it shouldlbgecto a sharp focus. If the
focus is still poor, then it may appear as a pak df light with a dark centre (the
secondary mirror shadow in an SCT, or NewtoniamwIselect the ‘File’ menu again
and click on ‘Focus frame centre’; you can now tiiemouse pointer to click on the
star image and the new focus frame co-ordinatdwitlisplayed. Now return to the
camera interface window and click on ‘Start’ in thecus frame. The computer will
now display a continuous series of 100 x 100 pixelges in the focus window and
you should see your selected star appear somewloseto the centre. A ‘peak
value’ (the value of the brightest pixel) will albe shown in the adjacent text box and
this can be used as an indication of the focusracguAlthough the peak value is
sensitive to vibration and seeing, it tends towardsaximum as the focus is
optimised. Carefully adjust the focus control omytelescope until the image is as
sharp as possible and the peak value reaches aomaxiWait for any vibration to

die down before accepting the reading as reliabteveatch out for bursts of bad
seeing, which reduce the apparent focus qualityteCiten, the peak value will
increase to the point where it is ‘off scale’ a@8@nd in this case you must halt the
focus sequence and select a shorter exposure ivighuto use the peak value as an
indicator. Once you are happy with the focus qualthieved, you might like to trim
the settings of your par-focal or flip mirror eyepé to match the current camera
position. Although you can reach a good focus leyahove method, many observers
prefer to use additional aids, such as Hartmanrksn@s objective cover with two or
three spaced holes) or diffraction bars (narrovalelrrods across the telescope
aperture). These make the point of precise focsieet determine by creating
‘double images’ or bright diffraction spikes arowstdrs, which merge at the setting
of exact focus. The 12-16 bit slider control alloyesi to adjust the contrast of the
focus frame for best visibility of the star imadfedefaults to maximum stretch (12
bits), which is generally ideal for stars, but wéwo stretch value is better for focusing
on planets.

Taking your first astronomical image:

| will assume that you are now set up with a fodusemera attached to a telescope
with an operating sidereal drive. If so, you argnio a position to take a moderately
long exposure of some interesting deep-sky astracadrobject (1 will deal with
planets later!). As most drives are not very adeubgyond a minute or two of
exposure time, | suggest that you find a fairlyghtiobject to image, such as M42,
M13, M27 or M57. There are many others to choosmfrbut these are good
examples.

Use the finder to align on your chosen object duath tcentre accurately by using the
focus frame and a short exposure of between 1 aedd@nds. The '12-16 bit’ slider
in the focus frame allows you to adjust the imageti@st if you find that the object is
too faint with a short exposure. Once properly htind focused, take an exposure
of about 60 seconds, using the ‘Fast’ mode andrebdbe result. Initially, the image
may appear rather barren and show only a few staveever, there is a great deal of

11
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data hidden from view. You can get to see a lahisf, without affecting the image
data, if you go to the ‘View’ menu and select ‘Al@ontrast Stretch Image’. The faint
image data will then appear in considerable datadl | think that you will be
impressed by the result!

If you are happy with the image, go to the ‘Fileéinu and save it in a convenient
directory.

Now you need a ‘dark frame’, if the best results tarbe extracted from your raw
image. To take this, just cover the telescope divjeevith the lens cap, or drop the
flip mirror to block the light path to the CCD (makure that this is light tight), and
take another 60 second exposure. This image wl pieture of the dark signal
generated during your exposure and it should bedsewth your image for use in
processing the picture. The SXV-M9 generates \#tg tark signal and so dark
frames are not essential for short exposures sfttemn a few minutes, but it is a good
idea to record at least one for each exposureused during an imaging session. As
variations in ambient temperature will affect tregldsignal, it is best to take the dark
frames within a few minutes of capturing your imageor the same reason, it is not
wise to use ‘old’ dark frames if you want the besssible results, however, some
software allows you to scale library dark framesnatch the image (e.g. AstroArt).

‘Flat fields’ are often recommended for optimisiihg results from your CCD
camera, but these are generally less importantdhdnframes, especially if you
make sure that the optical window of the cameta dust-free. The purpose of a
flat field is to compensate for uneven illuminatamd sensitivity of the CCD and it is
better to avoid the need for one by keeping thesglean and unvignetted. | will
ignore flat fielding for current purposes and ddsethe process in detail at a later
stage.

Processing the deep-sky image:

THE RAW IMAGE

1) Make sure the ‘Auto Contrast Stretch’ is switthdf and load your image into
SXV_M9. Select ‘Merge’ and then ‘Subtract Dark Feanick the appropriate dark

12
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frame and the software will then remove the dagkai from your image, leaving it
somewhat darker and smoother than before.

AFTER SUBTRACTING THE DARK FRAME

2) The resulting image will probably look faint andldwith a bright
background due to light pollution. It is now tineprocess the ‘luminance’
(brightness and contrast) of the image to get st Wisual appearance. First,
use the ‘Normal’ contrast stretch to darken thekgeaund by setting the
‘Black’ slider just below the main peak of the bigtam. Alternatively, you
can use the ‘Remove Background’ option to let thfeasare decide on the best
setting. This will greatly reduce the backgrounigibness and the image will
begin to look rather more attractive. You can nownbrightening the
highlights with another ‘Normal’ stretch, in whiglou bring down the ‘White’
slider to just above the main image peak. The $etting for this is rather
more difficult to guess and you may need sevetahgits before the result is
ideal. Just use the ‘Undo last filter’ functionniécessary, to correct a mistake.

THE FINISHED IMAGE +

13
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3) The image will now look quite impressive ancpk that you are pleased with
your first efforts! Further small refinements asually possible and you will become
expert at judging the best way to achieve thegmasexperience increases. As a
rough guide, the ‘Filters’ menu can be used tofsrarsoften or noise reduce the
image. Strong ‘High Pass'’ filters are usually ngioad idea with deep sky images, as
the noise will be strongly increased and dark riwdsappear around the stars, but a
‘Median’ filter can remove odd speckles and a Mildsharp Mask’ (Radius 3, Power
1) will sharpen without too much increase in noise.

Other things to try, include adjustment of the colsaturation and summing several
images for a better signal to noise ratio. Sumnsgnrg be done in the ‘Merge’ menu
and involves loading the first (finished) imagdges@ng a reference point (a star) then
loading the second image and finding the samenstarthe mouse. Once the
reference is selected, you can either add direatlgyerage the images together.
Averaging is generally better, as you are lesdylik@ saturate the highlights of the
picture. The signal-to-noise ratio will improveaatate proportional to the square root
of the number of summations (summing 4 imagesduillble the signal-to-noise), but
different exposures must be used. Summing an image witvdehot change the
S/N ratio!

Although | have concentrated on the use of a tej@séor deep-sky imaging, do not
forget that you have the option of using an ordiraamera lens for impressive wide-
field shots! A good quality 200mm F3.5 lens withiafiared blocking filter will yield
very nice images of large objects, such as M31, N5 etc. If you cannot obtain a
large IR blocker for the front of the lens, it isitg acceptable to place a small one
behind the lens, inside the adaptor tube.

Taking pictures of the planets:

Planetary imaging is in many ways quite differeoti deep sky imaging. Most deep
sky objects are faint and relatively large, so @ristocal length and a long exposure
are needed, while planets are bright and very smedlding long focal lengths and
short exposures. High resolution is critical toiagimg good results and | have
already shown how a suitable focal length can beutzied and produced, using a
Barlow Lens.

Many camera users comment on the difficulty of imgdthe correct focus when

taking pictures of Jupiter etc. This is usually dou@oor seeing conditions, which are
only too common, but may be due in part to pooliroaltion of your telescope.
Please ensure that the optics are properly aliggesdhown by star testing, or by using
one of the patent collimation aids that are widelgilable. It is also better to use a
star for initial focusing, as planetary detail iffidult to judge in bad seeing. Although
the star will also suffer from blurring, the eyenaaore easily gauge when the most
compact blur has been achieved!

You could begin by imaging lunar craters, but tbkvar content is low and so |
recommend Jupiter, Saturn or Mars. The rapid vanatof seeing which accompany
planetary imaging, will ruin the definition of abio®6% of your images and so |
recommend setting the camera to run in ‘Autosaveden This will automatically
take a sequence of images and save them with sia|d#@ names in your

14
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‘Autosave’ directory. Dozens of images will be sayvieut only one or two will be
satisfactory for further processing.

To start the Autosave process, call up the SXV Qarhrgerface and select the
‘Continuous Mode’ check box at the top (make sheerest are unchecked). Now
check the ‘Autosave Image’ checkbox near the bottbthe window. If you now
click on ‘Take Picture’ the automatic sequence dtin and will not stop until you
press a computer key. The images will be savedTia format with sequential names
such as ‘Img23, Img24...." and will be found in theutosave’ directory (or a sub-
directory of Autosave, set up in the program deaoienu).

The exposure time needed for good planetary imagasch that the image histogram
has a peak value at around 127 and does not exteck above 200 (Ignore the
major peak near zero, due to the dark backgrouihgdu use too short an exposure
time, the image noise level will be increased, imab long a time is used you will
saturate the highlights and cause white patchéseodecoded image. With the
recommended focal length, Jupiter and Mars wilhbwted an exposure time of
between 0.1 and 1 seconds and Saturn will needeleet®.5 and 2 seconds.

Processing a planetary image:

Planetary images have one major advantage oversitgamages, when you come to
process them — they are MUCH brighter, with a gpoadingly better signal to noise
ratio. This means that aggressive sharpeningdilteay be used without making the
result look very noisy and so some of the effe€{soor seeing can be neutralised.

A raw image

Try applying an ‘Unsharp Mask’ filter with a radio§5 and a power of 5. This will
greatly increase the visibility of any detail o thlanet, but the optimum radius and
power will have to be determined by experimengéneral terms, the larger the
image and the worse the seeing, then the wideaathias for best results. My Jupiter
shots are usually about half the height of the G@ihe and I find that the ‘radius 5,
power 5’ values are good for most average seeinditons. If you have
exceptionally good conditions, then a reductioR#8, P=3 will probably give a
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more natural look to the image, as too large ausadnd power tends to outline edges
with dark or bright borders.

As a finishing touch, the application of a Medidtef or a Weighted Mean Low Pass
filter can be useful to smooth out the high frequyenoise after a strong Unsharp
Mask.

As with deep-sky images, it is advantageous to glametary images together to
improve the signal to noise ratio. In this case,‘ttveraging’ option should always be
used, or the result is likely to exceed the dynaminge of the software and saturate
the highlights. Aligning the images is always sammgj of a problem, as there are
rarely any stars to use when imaging the planeits)ipiter’s satellites can be useful
reference points. Otherwise, you will have to fandell-defined feature on the planet,
or estimate where the centre of the disk is locéedne more sophisticated software
can automatically align planetary images, but hdofind it especially difficult to do
by eye.

kkkkkkkkkkkkkkkkkkkhkkkkkkkkkkkhkkhkkhkkhkkhkkkhkkkkkkkhkkhkk kkkkkkkkhkkkkkkkkkk

Other features of SXV_M9
‘Slew & Sum’ imaging:

The SXV-M9 can be used in an automatic image-stackiode, called ‘Slew &

Sum’. The camera is set to take several sequenmdsures, which are automatically
‘slewed’ into alignment and then summed togethethieysoftware. This mode can
help to overcome a poor RA drive by summing imabas have exposure times
shorter than the drive error period. The resulimgge has more noise than a single
exposure of the same total length, but this metfadhaging is still an effective way
of making long exposures.

To take an S&S image, go to the camera interfacelow and select an exposure
time for one image of the sequence. Do not useyashert exposure time, as the
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read-out noise will become dominant. About 30 sdsas a reasonable minimum.
Now go to the ‘Multiple Exposure Options’ and sélacyumber of exposures to take.
You can also select to average the images, rdthardadding them, and there is a
‘Alternative Slew Mode’ available, which uses tlarelation of image areas, rather
than a single star. This mode can be better inedstas fields.

Another option is ‘Auto remove dark frame’. Thisadvisable with S&S images, as
the slewing will mis-register the images with agté&ndark frame that is applied to the
finished sequence. To use this option, you willchaelark frame, taken with the same
exposure time as a single image from the sequdinteis stored on drive C with the
name ‘dark.def’

Now click on ‘Take Picture’ and the sequence wagim.
Using the High-Resolution modes:

Up to this point, | have assumed that the ‘Fastiging mode is being used. ‘Fast’ is
fine for most purposes, but it does not offer thiéviertical resolution of the
SXV_M9 CCD. Because of the CCD structure, it is asgible to read out all of the
pixels in a single sequence and so we must use Eomeof ‘double readout’ to get
the full 752 x 580 pixel resolution. This can bandon two ways, as follows:

1) Progressive mode:

In progressive mode, the exposure of both imadedfimkes place at the same time
and then each field is read out consecutively. dmapensate for the extra exposure of
the second field, caused by the readout of thg flte second field is deleted at one
‘readout interval’ into the exposure and integratgain from that point.

Exposures taken in Progressive mode will be leasaléhan those in Fast mode and
‘STAR 2000’ guiding cannot be used. However, thaltexposure time is not greatly
increased from that in ‘Fast’ mode and any motiotime dependent effects in the
subject will have a minimal damaging effect onithage.

2) Interlaced mode:

In this mode, two ‘Fast’ exposures are made, uginge full resolution line
displacement of the imaging fields from one expegarthe other. The images are
then combined to form the full resolution imageislimode gives a good image
density, but is more likely to show line to lineriaions due to differences in the
exposure timing etc. It can also show time relateahges as ‘jags’ in the image,
although this is usually due to guiding errors kEswthe two half frames.

As any exposure time errors, or variation in tramepcy, can cause line-by-line
brightness errors, interlaced images often shomé&tian blind’ patterns. The

‘vertical smoothing’ filter is provide for correaty these errors, or it can be enabled to
run automatically from the ‘Program Defaults’ menu.

Interlaced mode will work with STAR 2000 guiding.

Taking and using a flat field:
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Flat fields are images, which display only the &aans of illumination and

sensitivity of the CCD and are used to mathemdyicabdify a wanted image in such
a way that the errors are removed. Common flad #efors are due to dust motes on
the camera window and vignetting effects in thaogpsystem of the telescope. Dust
motes act as ‘inverse pinholes’ and cast out-ofifamages of the telescope aperture
onto the CCD chip, where they appear as shadomud®- Most optical systems
show some vignetting at the edges of the fieldeeisly when focal reducers are
used. This causes a brighter centre to show inesyagspecially when there is a lot of
sky light to illuminate the field.

If dust motes are your main problem, it is bestléan the camera window, rather
than to rely on a flat field to remove the do-niiat fields always increase the noise
in an image and so physical dust removal is thedgason. If you have serious
vignetting, first check whether the optical systesn be improved. The most likely
cause of this problem is trying to use too poweafdiegree of optical compression
with a focal reducer and you might want to try nmgvthe camera closer to the
reducer lens.

If you really do need to use a flat field for imag@rection, then it must be taken with
care. It is most important that the optical sysMdST NOT be disturbed between
taking your original images and taking the flatdieAny relative changes of focus
and rotation etc. will upset the match betweenfitdtl and image and the result will
be poor correction of the errors. The other netefsi recording a good flat field is a
source of very even illumination for the telescéipéd. This is surprisingly difficult

to achieve and many designs of light source hapeaed in the literature and on the
Web. These usually consist of a large wooden baxtaining several lamps and an
internal coating of matt white paint, which is mdoover the objective of the
telescope to provide an evenly illuminated surfad¢ese can work well, but | prefer a
simpler method, as follows:

Most imaging sessions begin or end in twilight andhe dusk or dawn sky can
provide a distributed source of light for a flalfi. However, using the sky directly is
likely to result in recording many unwanted stawrspatches of cloud etc., so a
diffuser needs to be added to the telescope. Aal idaterial is Mylar plastic
draughting film, obtained from an office suppliearehouse. It is strong and water
resistant and can be easily replaced if damageetcSta piece of the film loosely
across the aperture of your telescope and poinh#teiment high in the sky, to avoid
any gradient in the light near the horizon. Nowetakveral images with exposure
times adjusted to give a bright, but not overloagbécture. Averaging flat field
together is a good way to reduce their noise doution and so recording 4, or more,
images is a good idea.

To use your flat fields, they must first have akdiaame subtracted. Although this
may appear to be unimportant with such brightlafitd short exposures, there is the
‘bias offset’ of the camera in each image and ¢his produce an error in the final
correction. As we are mainly interested in the j#agy very short exposure dark
frame will give a good result. The dark subtragtaedges should then be averaged
together before use.

After the above procedures have been executedatifeeld will be ready for use.
Load up your image for processing, subtract th& ttame and then select ‘Apply
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flat field’ in the ‘Merge’ menu. The result shoude an image with very little sign of
the original artefacts.
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The accessory ports

The SXV-M9 is provided with two ports for use wahcessories. The Autoguider
output port is a 6 way RJ11 socket, which is combpatvith the standard autoguider
input of most telescope mounts. It provides 4 a&etow opto-isolator outputs and a
common return line, capable of sinking a minimundwiA per output. This socket
may be used for telescope control if the SXV-M@nsployed as an autoguider, but is
primarily intended to be the control output for thi@ional add-on autoguider camera
head, available for use with the SXV-M9.

]
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The autoguider output connections
as seen looking into the RJ11 socket

The high density parallel port socket provides bmhtrol and power for the add-on
autoguider, but also includes a pair of serialg@wt use with other devices.

Using the built-in serial ports

The SXV-M9 incorporates two fast serial ports feewvith external accessories. The
ports are available on 5 pins of the 18 way cororabit is provided for the
autoguider and may be accessed by plugging inrealsmert divider box’. The divider
box and cables are available as an accessory anerzhained in series with the
autoguider cable, when the guider is in use, or beaysed on its own.

The two serial connections are in the form of stmddRS232 PC style plugs and
provide TX, RX and Ground connections at RS232l&&ccess is via commands
sent through the USB connection and, at the timeriiing, is limited to any serial
controls that are provided by the SXV softwares kxpected that many more
functions will be added as the software is upgraded
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STAR 2000

The SXV-M9 may be used with our patented self-qugdystem ‘STAR 2000’. This
can greatly ease the process of recording longexpaleep-sky images.

Using ‘STAR 2000’ self-guiding with the SXV-M9

How S.T.A.R. 2000 works:

S.T.A.R. 2000 is a unique and patented method toinaatically controlling your
telescope drives, while capturing a long exposmage with your Starlight Xpress
CCD camera. Unlike off-axis guiding devices andldt@D self-guiding cameras,
S.T.A.R. 2000 can guide on almost any object, wigahsible within the CCD
frame! You have the entire CCD field of view to ose from and can even select a
slowly moving target, such as a comet nucleusstaraid, to guide on during the
exposure.

The principle of S.T.A.R. is based on the speci@aDGstructure of the chips used in
our SXV_M5, M7 and M9 cameras and it cannot be waéd ‘full frame’ CCDs,

such as the popular Kodak devices. It is also irgatible with our HX516 camera.
The M5, M7 and M9 use ‘Interline Interlaced’ CCDOpy which are constructed with
each pixel split into two vertically stacked halvEsach half can be ‘read out’
independently, so it is possible to integrate @lerposure on one field of half pixels,
while the other field is read out at short intesvahd the data used for guiding the
telescope. Half way through the exposure, we cad oait the contents of the
integrating field, swap fields, and integrate tastiof the exposure on the other field.
This preserves the best image resolution and eitea‘aliasing’ effects.

To give a fast guider update rate, the guidinglfislread out as an 80x40 window
around the guide object, while the unused linescammped’. Using this technique, it
is possible to feed corrections to the telescopedrs often as one every second
when guiding on a fairly bright star (typically alionag. 11). The sub-pixel guiding
accuracy of S.T.A.R. 2000 will give you tightly defd, round star images, however
long the exposure time that you use!

The advantages of S.T.A.R. are very great, buetheg two negative aspects, which
you should be aware of. The main loss is in thsisgity of the CCD, as only half of
the pixel area is integrating an image at any ane.tThis is slightly offset by the
halving of the dark current, which also resultg aan be completely compensated
for by increasing the exposure time — not a bidbf@m when the camera can guide
itself! The other problem is that the CCD amplifirust be switched on momentarily
to read out each guider frame. Despite the shodgiinvolved, this results in some
contamination of the upper left hand corner ofithage, by light emitted from the
amplifier transistors (electro luminescence), dns heeds the subtraction of a special
dark frame to remove it. However, the glow is qigti@t and may be ignored on
many images, or it can be removed with the ‘Gradiéier’ in the ‘Filters’ menu.

20



Handbook for SXV-M9 Issue 1 June 2004

What you need:

To use S.T.A.R. 2000, you must have a telescoge "iito guider’ capability. Most
modern SCTs have this facility in the form of ai {RJ11’ telephone style
connector on the mounting base or handset. If \smape is ‘ST4 compatible’ it
should work with S.T.A.R. 2000. Adaptors for otheounts, such as the Vixen
Skysensor, are available from Starlight Xpresshéncase of a ‘difficult’ mount, an
add-on relay box is available to switch higher eats and opposite polarity circuits.
The system has been tested with the LX200, LX50Geldstron CI700 German
mounts with good results, but almost any modernmhaiil work well. Please note
that the RJ11 cable supplied with the camera hasdhnectors fitted on opposite
sides of the 6 way cord — other cables may nobbepatible!

Setting up the system:

For best results, it is important to set up yolegeope mounting as accurately as
possible. Alt-Az mounts can be used with S.T.A.80@ but will cause field rotation
during exposures and are often rather poor at dmteoaxtking. We recommend that
you always use an equatorially mounted ‘scope, stpolar axis accurately aligned
on the pole. If your mount is prone to sudden shaftaim point during tracking,
usually due to poorly made gears or bearings, $1@A.R. will be unable to fully
compensate and some trailing will result. Slow smeboth errors in position are well
corrected and so this is what you should aim ftveck that all your drive gears are
firmly fixed to their shafts (loose gears are sigipgly common!) and that they
engage closely, without binding. The tracking ofnjanounts can be improved by
adding a deliberate bias to the East. A small weagithe Eastern fork tine will
usually be effective.

Connect up the computer and camera in the usuabwaynstall the camera onto the
telescope. Next, take the 6 way RJ11 telephonedradglug one end into the guider
output of the SXV camera. This output is a ‘switth&gnal, compatible with inputs
designed for use with an ST4 guider. It is alscsfiids to use a serial connection to an
LX200 compatible RS232 input, but to do this yoed&o have a serial port to RJ11
cable from the back of the computer to the RS2ptinf the mount. This connection
allows other ‘goto’ control signals to be senthe thount, but may be less convenient
if you do not require this facility. Which outpuby use will also depend on your
telescope, but the Meade LX200 and its clones @amgatible with serial control,
although the LX200GPS still has a software issubeatime of writing. All other
mounts will use the guider output from the caménace the above connections have
been made, you are ready to start up the system.

Starting to guide:

Power up the camera and computer, and start tbsctgbe drive. Click on ‘Set
Program Defaults’ and examine the current settillgthe ‘Telescope Guiding’ box,
set the interface selection to ‘LX200’, or ‘Via Qawl box’ (ST4 output of camera), as
appropriate. Also select ‘COM1’ or ‘COMZ2’ if usirggrial control, according to
availability - ‘COML1’ is the 9 pin port provided dhe rear panel of most portable PC
computers.

Now adjust the other values as follows:
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1. Set ‘RA Pixels per sec’ and ‘Dec Pixels per se®.to
2. Set all backlash and hysteresis values to 0.

3. Set ‘Ignore drift < 1 pixel’ to OFF.

4. Set '70mS delay between direction changes’ to ON.
5. Set ‘Default guide training time’ to 2 secs.

These values can be refined later, but should weakonably well with most
telescopes.

You can now test communications between the compuig telescope mount, as
follows:

1. Press ‘Set slew values’, followed by ‘Save Progiaefaults’.
2. Select ‘Telescope control’ in the ‘File’ menu.

3. Press each button in turn and observe the LED kintipe rear of the camera.
As each is pressed, the lamp will brighten and ghaolour between red and
green. The telescope will also begin to slew inappropriate direction. This
slew will be slow (unless you have deliberatelyestdd a fast slew mode via
the telescope controls) and so you will need teplesit through the telescope
eyepiece, by watching stars drift by. If the LX20@tput is in use, the LED
will not respond, but the ‘scope will still slewrcectly.

If all is well, you can proceed to testing the gagdsystem itself, otherwise, check
your setup and confirm that the correct COM paot ist selected.

Refit the CCD camera to the telescope and rotae that the mounting bracket is
aligned approximately East-West. Focus in the uaadl on a star and then point the
‘scope towards the object you have selected foginga | recommend something
near the celestial equator and with a reasonalstdauof useful guide stars around
it, to make life a little easier!

Take an image of the field, using an exposure bifrfesecond and selecting ‘Auto
contrast stretch’ in the ‘View’ menu. Several stsinsuld be easily visible in the
displayed image, but, if not, try increasing the@sure time a little. Remember that
the ideal guide star is one that is bright enowughet easily detected in a 1 second
exposure, or less.

Once you have the test image and can see an ajgbeoguide star, go to the ‘File’
menu and click on ‘Select guide star’. Now click thouse on the image, with the
pointer on your selected star. The pointer will puanto the star and a message box
will show its co-ordinates in a message windowesprOK’ to confirm the selection.
You have now selected the guide object and areyrastart an exposure.

Call up the camera control panel and select a dngefor the length necessary for
your guide star) exposure time. Click on the chaak ‘Self guide next exposure’ and
‘1 second’ should appear in the self guide expobore Now set the exposure for the
image (try 5 minutes as a good starting point) eiok on ‘Take picture’.
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The control panel will disappear and be replacethbyguider window, with a set of
number boxes above it. The guider software will rattempt to centre an 80 x 40
pixel box around the guide star and this will appedhe guider window after a few
seconds delay. The number boxes will also begshtav the star co-ordinates and the
differential guiding error as each new guide fisldisplayed.

If all is well, the error numbers will remain atrgeally less than 1 pixel and the star
image will sit steadily at the same location in ¢hede box. If, however, the star
begins to drift away, it is possible that your @riyuide directions are reversed in
either RA or DEC (or both). Press ‘ESC’ to stop ¢lxposure and go back to the ‘Set
Program Defaults’ menu, where you can use the ‘Swsgplirection’ and ‘Swap e/w
direction’ check boxes to reverse the appropriateedAnother problem, which can
arise, is that the star may remain close to theecoposition, but will oscillate around
it by two or three pixels, rather than holding mgateady. This can be due to several
different faults, such as poor drive accuracy, windnditions, or bad seeing, but may
also be caused by an excessive ‘Loop gain’ in ¢ffegaiider feedback loop. Try
increasing the ‘Pixels per second’ values in therapriate default setting box, until
stable following is achieved. Once the guider isupecorrectly, it should hold a guide
star within 1 pixel of its correct position indetely, and you can try taking test
exposures of various objects to confirm its accurac

After your first test of the self guider, thereaigiood chance that the set-up will still
need some optimising. You have the option of madnsaiting test values of
backlash and hysteresis, or using the ‘Trainingtiree in the software. Backlash is
the time delay between a reversal of a drive mamalthe start of a positional
correction of the telescope. Hysteresis is the tirtakes for a motor to stop, after the
power is removed. Many mounts have internal so#warcompensate for these
errors, but you may need to set values other teemtp get the best performance
from less sophisticated ones.

The ‘Training’ option can be used as follows:

Select a star to guide on, and then the driveitrgiperiod, using the ‘radio buttons’.
The best training time will vary with the resporspeed of the mount, but use as long
a time as possible, consistent with not losinggihiele star out of the guide window.
Start the training cycle and the software will tlseguentially drive the telescope in
all four directions, while recording the displacerhef the reference star. After the
cycle has completed, the optimum correction spdgatsklash correction and
hysteresis values will have been calculated aretted into the default boxes. Note
that the pixels per second rate for the R.A. coiwaawill vary with the cosine of the
declination angle, so you may need to alter thigejaor re-train the system when
changing between objects at widely different dextlons.

Exposure times and image calibration

S.T.A.R. 2000 will enable you to greatly extend ¢ix@osure times of astronomical
images and so detect much fainter objects. Theitighfactor is set largely by the
increasing effect of light pollution on these exted exposures, but dark sky sites will
permit 30 minutes, or more, to be used. You wgbdbegin to see signs of amplifier
luminescence at the upper left-hand corner of ymages and this will make dark
frame subtraction more important than usual.
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The software includes an option to generate prgpedtched dark frames, by
recording the number of guiding downloads execdtathg the taking of the image
and using this to add the correct amount of angplgiow to the resulting dark frame.
To use this option, you must record the dark fraimmediately after the ‘light

frame’, or the download count will be lost. Simplyver the ‘scope aperture, select
‘Take matching dark frame’ in the self guider pafrthe camera control interface and
press ‘Take Photo’. Application of the ‘Gradientdr’ (under the Filter Menu) can be
used as a final ‘tweak’, if necessary.

Flat field frames can be taken in the usual wag, @ not affected by the use of
S.T.A.R. 2000.

A clip from a self-guided ‘STAR 2000’ SXV-M9 image
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Using the add-on autoguider:

An alternative to STAR2000 and a very useful acmgsis the add-on autoguider
head, which takes its power and control signaksadly from the SXV camera, via the
18 way socket on its rear panel. The autoguidenig 1.25” in diameter and has a
video style ‘CS’ mount thread in its nose, so vitlstses may be attached. The guider
may be used with either an off-axis prism assemimynted in front of the SXV
camera, or with a separate guide telescope, rigidlynted alongside your imaging
telescope. | personally use it with an 80mm aperk#, inexpensive refractor as a
guide ‘scope, but a shorter focal length lens milke more guide stars available in
any given region of sky (See the picture below).

To use the autoguider, first orient it so thatebanector plug is roughly parallel to
the declination axis of your mount. This is not@hbtely essential, as the training
routine will learn the angle of the head and conspémfor it, but it is easier to
understand the motion of the guide star if the gufdame is aligned with the RA and
Dec axes. Now connect the head to the SXV camerag the 18 way connector lead,
including the port divider box, if it is to be used

The recommended way of connecting the autoguidgubto the mount is to use an
RJ11 telephone lead between the socket on the SX\é¢@ and the autoguider input
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of your mount. This output is ‘active low’ (i.e.eftontrol relays pull the guider inputs
down to zero volts when applying a guide correqtenmd matches most of the
autoguider inputs on commercial mounts. If ‘actmgh’ inputs are needed, or a very
low control voltage drop is essential, then yod wéed to add a Starlight Xpress
‘relay box’ between the guider output and the injpuhe mount. Please contact your
local distributor if a relay box is required. Someunts (Vixen, for example) use a
similar guider input socket, but have re-arrangaghections. Details are given on our
web pages at the end of the ‘STAR2000’ section.

The autoguider installed on a 80mm refractor gtsdepe in the author’s garden
To use the autoguider, please proceed as follows:

1) Having started the SXV-M9 software, open the autdgucontrol panel by
clicking on the autoguider menu button.
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Auto Guider Camera Control
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The autoguider control panel with a guide starcdete

Press the ‘Start’ button and a series of 1 secapdsire guider images will
begin to appear in the picture frame. If the imdgek too dim, use the
‘Stretch Image’ slider to increase its contrast bBrightness until the noise
begins to be visible.

If you haven't focused the guider lens or ‘scopeyethe mount until a bright
star is visible on the guider image and then adhesfocus until it is as sharp
as possible.

At this point, you may want to test the guiding tohby pressing the manual
‘Move Telescope’ buttons at the bottom left corakthe control panel. You
can watch the position of any stars in the guidexge and confirm that they
move in response to the buttons. The movement ghmutlow if the correct
guiding rate is selected on your mount (typicakysiereal). Adjust this, if
necessary.

Move the mount until the required object for imagia properly framed in the
main CCD image (leave the guider menu and use #ie camera control
panel, as necessary).

Re-open the guider control panel, start imagingtantb locate a clearly
visible guide star. If necessary, make adjustmentise guide telescope or off-
axis guider until one is found.

Press ‘Stop’ and then press ‘Select Guide Stae. te mouse to left click on
the selected star and a green cross will highligintd the co-ordinates will
appear in the text boxes above the image window.

The various guiding rate defaults, listed on tigltihand side of the control
panel, are unlikely to be perfect for your parteouelescope and mount. You
have the option of manually selecting values, &masthe software to attempt
to determine what they should be. This is donerkgging the ‘Train’ button
and waiting for the software to complete a sequefe@tomatic moves and
calculations. The training will also determine #rgle at which the guide
camera is oriented with respect to the RA and Des.Af you do not wish to
train the system at this time, the default values pixels per second will
serve as a starting point.

26



Handbook for SXV-M9 Issue 1 June 2004

9) Now press ‘Go to main camera’ and the guider copi@oel will be replaced
by the camera control panel. Set the required expdsme for the image (say
5 minutes) and press the ‘Autoguide next imagetdmutThe autoguider
window will reappear and, after a few seconds, stoould see error values
appearing in the text windows at the top. The gside will be fairly close to
the green cross, although not necessarily accyregeitred, and you should
see the power/ guide LED on the rear of the cammeghten and change
colour with each correction.

10)If the star begins to drift away from the crosssplte the corrections being
made, the chances are that the N/S and/or E/Wtidinscare set wrongly.
Judge which axis is incorrectly set by observirgdirection of the drift and
then stop the exposure by pressing ‘Esc’. Opemytier control panel and
check the appropriate swap box(es). After this afp@m, you will probably
need to find the guide star again by taking a guitl@age and reselecting the
star, as before. Now return to the main camera raedtiry the ‘Autoguide
next image’ button again.

11) Once guiding is taking place without problems, tieen exposure can be
allowed to finish and, if all is well, you shouldesan image with tiny circular
stars.

If the stars are not circular, you may need tarahlie guiding parameters, or
investigate the rigidity and drive performance ofiymount. A lot of information
can be deduced by watching the behaviour of theéegstiar in the guider frame. If
it is continually moving between two locationsheit side of the green cross, then
the RA or Dec pixels per second value is set teo the higher these values are
set, the gentler the guiding becomes. Too low aevalill cause an over-
aggressive correction to be made and result iflason of the star position
between two points.

Another source of guiding errors can be a too ately balanced telescope
mount! Good balance can result in the telescopentrtbouncing’ between the
gear teeth as corrections are made. A simple tia &d a weight of about 0.5kg
(1 pound) on the eastern end of the declinatios, & that there is always some
pressure acting against the gear teeth.

Getting a good result from an autoguider will ofeartail a lot of detective work
to eliminate the sources of gear error, telesctgpaife, mirror shift etc., but the
final result is well worth the effort!
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Camera maintenance:

Very little maintenance is needed to keep the SX¥iexcellent operating order,
however two problems, which are common to all C@Dipment, are likely to show
up on occasion. These are dust and condensation.

Removing Dust:
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1) Dust can be deposited on either the optical ain¢hot a big problem to cure), or
on the CCD faceplate (difficult to eliminate enly)e When small particles collect on
the window they may not be noticed at all on ddgp(small F ratio) images, as they
will be very much out of focus. However, if a pofticontrast boost of the image is
carried out, they may well begin to show as theletia’'Do-nuts’ mentioned earlier.
Images taken with a large F ratio optical systeenmaore likely to be affected by such
dirt, owing to the smaller and sharper shadowsttiet cast. There is no great
difficulty in removing such particles on the outsisurface by the careful use of a lens
cleaning cloth or ‘air duster’ and so you shoulgénhttle trouble with this aspect of
maintenance. Dust on the CCD faceplate is a muehitgr nuisance, as it casts very
sharply defined and dark shadows and it entailsantling the camera to get rid of

it! To clean the CCD you will need a good qualéys cloth (no silicone) or tissues
and some high-grade isopropyl alcohol. A very sié@aloth is the ‘Micro-Fibre’

type marketed by PENTAX etc., and suitable alcahalvailable from TANDY

(Radio Shack) etc. as tape head cleaning fluidrighblight and a strong
watchmakers eyeglass will also be found essential.

Procedure:

1) Disconnect the lead from the camera head andwverih from the telescope. Place
it on a table with the optical window facing dowmaia

2) Remove the two M3 screws from the camera baatfe @nd ease the plate out of
the camera body. You may need to press down witigar on the USB socket while
pulling up on the camera barrel to overcome tedidnm.

3) Withdraw the body cylinder and unscrew the tasog spacer pillars from the heat
sink plate assembly.

4) The entire camera electronic assembly can noliteed away from the camera
front barrel and the CCD will be readily accessillete that a layer of white heat-
sink compound is applied to the periphery of thattsenk disc and this should be left
undisturbed by subsequent operations.

5) You can now closely examine the CCD faceplatdeuthe spotlight using the
watchmaker's glass when any dust motes will shewarly. If there is only an odd
particle or two and the CCD is otherwise cleaneftdly brush away the dust with a
corner of your lens cloth. A smeared or very d@GD will need a few drops of
alcohol to clean thoroughly and you may have toersdveral attempts before the
surface is free of contamination. One gentle wipenfone end to the other, with no
return stroke, will be found to be the most effeetaction. DO NOT rub vigorously
and be very careful to avoid scratching the window.

6) Before re-assembly, make certain that the insigttace of the front window is also
clean, and then carefully replace the camera fsantel and screw it into place. (If the
heat sink seal is disturbed, renew it with fresmmpound before reassembling).

7) Replace all the camera parts in reverse ordetlanjob is done.
Dealing with condensation:

TheSXV-M9 is designed to avoid condensation by miningghe volume of air
trapped within the CCD cavity. This normally woudusite well, but storage of the
camera in a humid location can lead to the tragpeblecoming moist by diffusion
through the optical window mounting thread etc. egglilt in condensation on the
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CCD window. If this becomes a problem, try to stibre camera in a warm, dry place,
or in a plastic lunch box containing a sachet liéaigel desiccant.

N.B. DO NOT leave the camera switched on for long periods between uses. The
cold CCD will collect ice by slow diffusion through any small leaks and this will
become corrosive water on the cooler and CCD pins when the power isremoved. | f
substantial amounts of moisture are seen on the CCD, dismantle the camera and
dry it thoroughly.
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Alternative Software

Although we hope that you will be satisfied witix® M9’, other companies are
offering alternative software. The most active andcessful of these is ‘AstroArt’ by
MSB software. You can purchase AstroArt from maegldrs Worldwide and more
information may be obtained from their web sit@idp://www.msb-astroart.com

Maxim DL is also a very popular option and may bechased from many
astronomical equipment dealers. Their web sité gtp://www.cyanogen.com
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Some details of the camera and CCD characteristics

CCD type: Sony ICX423AL ‘SuperHAD’ interline CCD imager.

CCD size: Active area 8.72 x 6.5mm
Pixel size: 11.6 x 11.2uM
QE peak: approx. 60% at 520nM

Spectral response:
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Power consumption: 220v/ 110v AC @ 12 watts max., 12v DC @ 750mA
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Dear User,

Thank you for purchasing a Starlight Xpress CCDdimg System. We are confident that you will gain
much satisfaction from this equipment, but ple&selrcarefully the accompanying instruction manual
to ensure that you achieve the best performancesticapable of providing.

As with most sophisticated equipment a certain arhotiroutine maintenance is necessary to keep the
equipment operating at its optimum performance. faetenance has been kept to a minimum, and is
fully described in the manual.

In the unfortunate instance when the equipment doeperform as expected, may we recommend that
you first study the fault finding information sujgal. If this does not remedy the problem, then acint
Starlight Xpress for further advice. Our messagarthservice on the Starlight Xpress web site will
often provide solutions to any problems.

The equipment is covered by a 12-month guaranteericw faulty design, material or workmanship in
addition to any statutory Consumer Rights of Pusehs

CONDITIONS OF GUARANTEE

1) The equipment shall only be used for normal pses described in the standard operating
instructions, and within the relevant safety staddaf the country where the equipment is used.

2) Repairs under guarantee will be free of chargeiding proof of purchase is produced, and that th
equipment is returned to the Service Agent at trelser’s expense and risk, and that the equipment
proves to be defective.

3) The guarantee shall not apply to equipment dachdy fire, accident, wear an tear, misuse,
unauthorised repairs, or modified in any way whewgo, or damage suffered in transit to or from the
Purchaser.

4) The Purchaser’s sole and exclusive rights utiderguarantee is for repair, or at our discretlmn
replacement of the equipment or any part therewf,r@ remedy to consequential loss or damage
whatsoever.

5) This guarantee shall not apply to componentstthae a naturally limited life.

6) Starlight Xpress's decision in all matters rsali and any faulty component which has been replac
will become the property of Starlight Xpress Ltd.

For further info. or advice, please call:

Mr Michael Hattey,

Starlight Xpress Ltd.,

The Office, Foxley Green Farm,

Ascot Road, Holyport,

Berkshire,

England. SL6 3LA

Tel: 01628 777126

Fax: 01628 580411

e-mail: Michael.hattey@starlight-xpress.co.uk

Web site: http://www.starlight-xpress.co.uk
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